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 Chapter 1. Overview

This manual describes how to use BULLETIN, an application that allows a site to
distribute news and information to its employees in a timely and efficient manner.
Using the site's VM services, information that was traditionally distributed by
hardcopy postings on wall-mounted bulletin boards can now be immediately
accessed by employees from host-connected terminals and displays in their work
areas.

Who should read this document?
Anyone interested in learning to use BULLETIN.

 Related Publications
� BULLETIN Installation and System Administrator's Guide

� BULLETIN Publisher's Guide

� IBM Systems Application Architecture - Common User Access Basic Interface
Design Guide, SC26-4583.
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Chapter 2. Changes in BULLETIN 1.1

This newest release of BULLETIN contains the following features and changes:

� An "All Notices" function has been added to the Category Listing Panel. This
function lists all the notices published in any selected category in the past 90
days.

This time period (90 days) was chosen to avoid overloading the system when
used with Local Categories, where notices are often kept in the database for
long periods of time. Ninety days is also the default length of time that notices
posted in the National categories remain in the BULLETIN database before
they expire.

The various functions available on the Action Bar under "Search" should
continue to be used if you need to obtain notices more than 90 days old.

� A new entry line on the Notice Listing, Stored Notices, and Search Results
panels allows you to apply a function to all notices in the list by typing only a
single action code. This line ("Apply to all notices in this list") will always
appear just below the header, even when scrolling forwards and backward.

For example, if an 'R' is typed on this line, all notices in the list will be marked
for reading. The Cancel PF Key is used to advance from one selected notice
to the next.

An action code entered next to an individual notice will take precedence over
one entered in the "Apply to all" line when that notice is processed.

� The EXIT function is now supported in the Copy Notice, Send Notice, and
Feedback functions, and you will be returned to the Notice Listing panel that is
currently active.

If you use the "Apply to all" feature to specify an action code for all notices and
then EXIT before you have completed with the list, the remaining notices will be
marked with that action code in their entry areas. You can then make any
changes you want, and press Enter to resume.

� When reading a notice, the Category and Topic will appear next to the date.
This feature does not apply for notices published prior to this latest release of
BULLETIN.

� An XEDIT panel is used to compose Feedbacks and messages attached to
notices sent to other users. This eliminates the limits previously associated
with text in the "Feedback" (24 lines) and "Send Notice" (5 lines) functions.
Using the command line in the panel, users can get other files to imbed in the
message, and invoke tools such as PROOF to perform spell checking.

� When you use the PROFS/OVVM option to send Feedbacks and copies of
notices to other users, the resulting file will now resemble an actual
PROFS/OVVM note, with "From:", "To:", and "Subject:" lines.

� Copies of Feedbacks will be appended to a file on your A-disk called
FEEDBACK BULLETIN. The previous name (FEEDBACK NOTEBOOK)
caused problems with some PROFS-related programs.

� If the file you specified in the "Copy Notice" panel already exists, you can now
also append the notice to the end of that file, in addition to replacing the file or
specifying a different file name.
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� The various Required Reading (REQD) categories and topics that are enabled
on your system are now indicated in the Subscription Panels. (Notices posted
in Required Categories and Topics are automatically displayed for you
whenever you invoke the "New Notices" function, either manually or by
subscriptions.)

� When a "Search by notice title" or "Search by notice content" will involve more
than 200 notices, you will be told the total number of notices and asked if you
wish to continue.

� The $BULLET$ USERDATA and $BULLET$ REMINDER files (which keep
track of the last notices you read and your Stored Notices) will be automatically
updated to reflect any renaming of categories and topics.

� A warning panel will be displayed whenever any of your Stored Notices is
within 7 days of expiring. You should then either process the Stored Notice
and delete it, or copy it to one of your minidisks. You will also be told if the
notice is no longer in the database.

This panel will also tell you if the assignments for your PF Keys or colors and
highlightings have been corrupted. If so, they will be reset to the system
defaults.

� You now have the capability of executing BULLETIN only if new notices have
been posted in your subscribed categories and topics. This is done by invoking
BULLETIN with the argument 'NEW': ie., 'EXEC BULLETIN NEW'

� References and links to NATBOARD have been removed.
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 Chapter 3. BULLETIN Architecture

What is BULLETIN?
A company's competitive edge can depend on getting correct information to the
right people as quickly and efficiently as possible. And the more organized and
easy to access that information is, the better the company's employees will be able
to utilize it. BULLETIN offers a simple, effective way to disseminate information
throughout an organization in a way that can be easily utilized by the company's
employees.

BULLETIN is a set of programs that performs electronic bulletin board functions,
distributing notices posted by corporate and local communications departments to
employees who need the information. BULLETIN provides a Publishing Utility
(described in the "BULLETIN Publisher's Guide") that simplifies the publication and
correct distribution of information. The end-user portion of BULLETIN allows the
employees to better utilize the published information and makes finding, viewing,
and responding to notices simple and speedy.

In the past, the main way to communicate with employees was by hardcopy
postings on the wall-mounted bulletin boards throughout their buildings. Notices
were either typed directly onto official stationary or cut and pasted, sometimes with
help from the artwork department. Sufficient copies to accommodate the entire site
were printed (many times in the hundreds for large locations), and were then given
to the mail room for posting on the boards.

Special mid-day announcements required additional trips for posting on the boards.
There was also no guarantee that the employees were aware of these special
postings.

BULLETIN provides a more efficient method of communication. While logged on to
a VM system, employees can access notices published by local or site
organizations, as well as notices created by regional or national organizations.

The features provided by the BULLETIN end-user interface include:

� Display today's notices

 � Read notices

� Search for past notices by date, category, or a word appearing in the title or
text of the notice

� Send comments or questions to the owner of the notice

� Copy notices to a minidisk

� Send notices to other end-users

� Print copies of notices
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How are notices stored?
Each notice that appears on the bulletin board is contained in a flat text file. During
the publishing process the notice is formatted for viewing on a display terminal. A
sample notice is shown on the following page.

Thursday, August 1, 1991 (CORP NEWS)

J. B. STONE NAMED TO NEW POST
 _____________________________

John B. Stone has been named director of quality, reporting to Tom
Goodyear, vice president.

Mr. Stone was director of operations, Computer Services.

End of Notice

Figure 1. Sample notice

The file begins with the date of the notice and the title, which is underlined. The
words "End of Notice" appear at the bottom of the notice.

Those notices published using BULLETIN 1.1 will have the Category and Topic of
the notice listed in parentheses after the date. Notices published with previous
releases of BULLETIN will show only the date.

How are notices organized?
Notices are grouped by four character Category  and Topic  codes. Each category
may have several topics associated with it. The category and topic classifications
allow notice publishers to target news to a specific segment of the population. It
also allows the end-users to select the notices that are of interest to them. In
general, the category is used to identify the organization that originated the notice,
while the topic is used to identify the subject matter of the notices. For example,
the following is a list of sample category and topic classifications.

Category Topic Description
-------- ----- ------------------------------------------------------
CORP NEWS General news from Corporate Headquarters
CORP PERS Personnel announcements from Corporate Headquarters
NE QC Quality Control information for the Northeast Region
NYC EDUC Education classes offered in New York City
NYC TECH Technical news in New York City
WACO CAFE Weekly cafeteria menu for the Waco, Texas facility

The BULLETIN system administrator at your location is responsible for defining the
categories and topics available on your system. Consult your system administrator
if you have any questions.
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Notices are stored on the system using the following naming convention:

FILENAME:  Consists of the year, month, day, and a sequence number.
Sequence numbers are assigned for each category/topic combination.

FILETYPE:  The first four characters are the category, and the last four characters
are the topic. The character '$' is used as a fill character for categories and topics
less than four characters long.

For example, the name 92031804 NE$$QC$$ would be for the fourth notice (04)
published on March 18, 1992 (920318) for the 'QC' topic (QC$$) in the 'NE'
category (NE$$). Remember that '$' is used as a fill character as described above.

An expiration date is assigned to each notice which determines how long it remains
in the database. Each day the expired notices are automatically erased from the
database.

Each notice also has a contact person assigned to it. BULLETIN contains a
feedback facility that allows end-users to ask questions and make comments about
individual notices. The feedback message is then sent electronically to the
designated contact person.

 BULLETIN functions
The following is a list of the functions that are provided by BULLETIN. The
individual functions will be described in more detail later in the manual.

Function Description

Color definitions Alter the colors of the screen items

Copy notice Copy a notice onto a minidisk

Environment Change the BULLETIN environment settings

Feedback Send comments on an individual notice to the notice
originator, or send general comments on the BULLETIN
application to the local administrator

New notices List all new notices published since the last access

PF Key assignments Alter the PF Key assignments

Print notice Print a notice

Read notice Display the text of a notice

Search by category Look for notices in the database by category

Search by date Look for notices in the database by date

Search by notice content  Look for notices in the database that contain the search
string within the text of the notice

Search by notice title Look for notices in the database that contain the search
string in the title

Send notice Send a copy of the notice as a CMS file or
OfficeVision/PROFS note to other users

Stored Notices Flag notices to be viewed or processed at a later date
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Subscriptions Allow the end-user to select which categories/topics are
of most interest to them. Notices from these categories
will be automatically displayed when BULLETIN is
invoked.
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 Chapter 4. BULLETIN Panels

 Primary panels
There are three primary panels that are used to display information:

1. Category Listing. Displays the list of national and local categories available at
your installation. From this panel you can either obtain a list of new notices in
various categories or subscribe to one or more categories.

2. Notice Listing. Displays a list of notices in the categories and topics you have
selected.

3. Read Notice. Displays the text of a selected notice.

 Action bar
There are five action bar items that appear on BULLETIN's primary panels:

Item Description

File Perform functions involving the objects displayed in the
panel (such as read new notices in a category, copy an
individual notice, etc.) and exit.

Search Access the notice search functions and alter the
display/grouping of daily notices.

Feedback Send comments and questions about BULLETIN or an
individual notice.

Options Customize the BULLETIN environment and operation.
End-users may alter their PF Key definitions, screen
colors, specify print routines, etc.

Help Additional information concerning BULLETIN.

To activate an action bar item, the end-user places the cursor anywhere on the
item, or in the space directly in front of it, and presses Enter. The PF Key labelled
"Actions" can be used to move the cursor to the action bar, where the Tab key can
then be used to jump the cursor from item to item. After pressing Enter, an action
bar pull-down will appear that lists all the choices for that action bar item. Once the
action bar pull-down has appeared, cursor movement and panel processing is now
restricted to the action bar and pull-down areas. You can cancel a pull-down by
using the Cancel PF Key, or you can activate another pull-down by moving the
cursor to another action bar item and pressing Enter.

To select a function listed on a pull-down panel, move the cursor to the function
name and press Enter, or type the corresponding number in the pull-down entry
field (the underscore to the left of the first option in the pull-down panel), and then
press Enter.
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Sample panel layout
The following is an example of a BULLETIN panel.

à@ ð
▌1▐File Search Feedback Options Help

 ---------------------------------------------------------------------------
 ▌2▐Notice Listing
 ▌3▐
Select notices by typing '/' or an Action Code, then press Enter
A=Add to Stored Notices C=Copy F=Feedback P=Print R=Read S=Send

 Act Thurs Cat Top Title
▌4▐_ . . . . . . . . . All notices in this list ...

_ 08/01/91 NYC PEOP J. A. Erickerson Named Business Director ...
 _ 08/01/91 US PEOP\Promotions

_ 08/01/91 WACO CAFE Cafeteria Menu for Wednesday, July 31
_ 08/01/91 US PEOP New Assignments in US Sales Staffs
_ 08/01/91 CORP NEWS J. B. Stone Named to New Post
_ 08/01/91 US NEWS J. B. Stone Named to New Post

 ▌3▐
 ▌5▐
▌6▐Command ===> ________________________________________________________________
▌7▐F1=Help F3=Exit F4=Prev Day F5=Next Day
 F9=Cmd Line F10=Actions F12=Cancel

á ñ

This sample is used to point out the major elements of a BULLETIN panel. These
are:

▌1▐ Action bar: Contains the available application actions. It is positioned
across the very top of the primary windows. Each action name represents a
group of related additional actions that will be displayed on the associated
pull-down panel.

▌2▐ Panel Title: Describes the information in the work area. All panels must
have a panel title. In this sample the panel title is Notice Listing.

▌3▐ Work Area: The space between the panel title and the message area. On
the sample panel the ▌3▐ symbol is used to mark the start and end of the work
area.

▌4▐ Action Entry area: Used to enter action codes listed in the work area. In
this example the available action codes are: '/', 'A', 'C', 'F', 'P', 'R' and 'S'.

▌5▐ Message Area: The line where informational, warning, and action
messages are displayed. This line is immediately above the command area.

▌6▐ Command Area: A line where the end-user may issue CMS commands
without leaving the application. It is indicated by the character string Command
===>.

▌7▐ Function Key Area: Displays common actions and application-defined
actions that end-users can request by pressing a PF Key.
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BULLETIN pull-down panels
The following figures show the contents of the pull-down panels used by
BULLETIN. To access a pull-down panel, move the cursor to the appropriate item
on the action bar and press Enter. Since these panels will be referred to
throughout the manual, it may be helpful for the reader to glance through the
pull-down panels at this point.

Category Listing panel pull-downs

File Search Feedback Options Help
------------------------------------------------------------------------------------
 | _ 1. New notices... |
 | 2. All notices (90 days)... |
 | 3. Subscribe... |
 | 4. Exit |
 --------------------------------------

Figure 2. File pull-down - Category Listing panel

File Search Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. Search by date... |
| 2. Search by category... |
| 3. Search by notice title... |
| 4. Search by notice content... |
| 5. Notices/Stored Notices |

 -----------------------------------------

Figure 3. Search pull-down - Category Listing panel

File Search Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. About the BULLETIN program... |
 ----------------------------------------------

Figure 4. Feedback pull-down - Category Listing panel

File Search Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. Subscriptions... |
| 2. PF Key assignments... |
| 3. Color definitions... |

 | 4. Environment... |
 -----------------------------------

Figure 5. Options pull-down - Category Listing panel
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File Search Feedback Options Help

------------------------------------------------------------------------------------
| _ 1. Help for help |
| 2. Extended help |
| 3. Keys help |
| 4. Basic instructions |
| 5. New this release |

 | 6. About |
 ------------------------------

Figure 6. Help pull-down - Category Listing panel

Notice Listing panel pull-downs

File Search Feedback Options Help
------------------------------------------------------------------------------------
 | _ 1. Read notice |
 | 2. Copy notice... |
 | 3. Send notice... |
 | 4. Print notice... |
 | 5. Add to Stored Notices |
 | 6. Delete Stored Notice |
 | 7. Exit |
 -----------------------------------

Figure 7. File pull-down - Notice Listing panel

File Search Feedback Options Help
------------------------------------------------------------------------------------

| __ 1. Next day's notices |
| 2. Previous day's notices |
| 3. Today's notices |
| 4. Display all new notices |
| 5. Search by date... |
| 6. Search by category... |
| 7. Search by notice title... |
| 8. Search by notice content... |
| 9. Cancel searches |
| 10. Notices/Stored Notices |

 -------------------------------------------

Figure 8. Search pull-down - Notice Listing panel

File Search Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. About this notice... |
| 2. About the BULLETIN program... |

 -------------------------------------------

Figure 9. Feedback pull-down - Notice Listing panel
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File Search Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. Subscriptions... |
| 2. PF Key assignments... |
| 3. Color definitions... |

 | 4. Environment... |
 -----------------------------------

Figure 10. Options pull-down - Notice Listing panel

File Search Feedback Options Help

------------------------------------------------------------------------------------
| _ 1. Help for help |
| 2. Extended help |
| 3. Keys help |
| 4. Basic instructions |
| 5. New this release |

 | 6. About |
 ------------------------------

Figure 11. Help pull-down - Notice Listing panel

Read Notice panel pull-downs
The action bar displayed on the read notice panel contains only four choices. The
search operation is not available when reading an individual notice.

File Feedback Options Help
------------------------------------------------------------------------------------
 | _ 1. Copy notice... |
 | 2. Send notice... |
 | 3. Print notice... |
 | 4. Add to Stored Notices |
 | 5. Delete Stored Notice |
 | 6. Exit |
 -----------------------------------

Figure 12. File pull-down - Read Notice panel

File Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. About this notice... |
| 2. About the BULLETIN program... |

 ----------------------------------------------

Figure 13. Feedback pull-down - Read Notice panel
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File Feedback Options Help
------------------------------------------------------------------------------------

| _ 1. Subscriptions... |
| 2. PF Key assignments... |
| 3. Color definitions... |

 | 4. Environment... |
 -----------------------------------

Figure 14. Options pull-down - Read Notice panel

File Feedback Options Help

------------------------------------------------------------------------------------
| _ 1. Help for help |
| 2. Extended help |
| 3. Keys help |
| 4. Basic instructions |
| 5. New this release |

 | 6. About |
 ------------------------------

Figure 15. Help pull-down - Read Notice panel
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 Chapter 5. BULLETIN Operation

Note:  The actual information displayed on the screens will vary depending on how
BULLETIN has been installed at your site. Specific questions should be directed to
your site's BULLETIN system administrator.

How to invoke BULLETIN
BULLETIN can be invoked from the CMS READY prompt, a CMS command line, or
a PROFS or OfficeVision command line. To invoke BULLETIN, just type:

 BULLETIN

BULLETIN also has a Fastpath capability, where end-users can bypass the
category listing panel and go directly to the new notices in a given category. The
format is:

 BULLETIN cccc

where cccc is the one- to four-character category name.

Contact your VM system programmer or BULLETIN administrator if you have any
questions about how to access your local BULLETIN system.

 Copyright IBM Corp. 1992  15



  
 

Category Listing panel

à@ ð
File Search Feedback Options Help

 ---------------------------------------------------------------------------
 Category Listing

Select Categories by typing '/' or an Action Code, then press Enter.
A=All notices (90 days) N=New Notices S=Subscriptions

 More: +
 Act Description
 Local News

_ NYC - New York City

 National News
_ REQD - Required Reading
_ AFR - Africa News
_ ASIA - Asia News
_ AUS - Australia News
_ CAN - Canada News
_ CORP - Corporate News
_ EUR - Europe News
_ SA - S. America News

Command ===> ______________________________________________________________
 F1=Help F3=Exit
 F8=Forward F9=Cmd Line F10=Actions F12=Cancel

á ñ

Figure 16. Sample Category Listing panel

The category listing panel is the first screen that the end-user will see when they
invoke BULLETIN. This panel lists all of the national and local news categories
that are available on this system.

In order to view new notices in any of the various categories,

� Type the 'N' action code in the entry field before each category of interest, then
press Enter.

� Select the categories of interest by typing a '/' in their entry fields, leaving the
cursor in the work area, and press Enter. This will execute the default function
for this panel, which is to display new notices.

� Select categories of interest by typing a '/' in their entry fields. Place the cursor
in the action bar area and press Enter. The categories will change color,
indicating that they are now "Selected Fields." The end-user may now select
the appropriate action bar function. In this case, to read the new notices, move
the cursor to the "File" action bar selection and press Enter. Then select "New
notices" from the pull-down panel displayed.
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Notice Listing panel
After selecting the categories to view, you will be presented with the notice listing
panel. An example is shown on the following page.

à@ ð
File Search Feedback Options Help

 ---------------------------------------------------------------------------
 Notice Listing

Select notices by typing '/' or an Action Code, then press Enter
A=Add to Stored Notices C=Copy F=Feedback P=Print R=Read S=Send

 Act Thurs Cat Top Title
_ . . . . . . . . . All notices in this list
_ 08/01/91 NYC PEOP J. A. Erickerson Named Business Director ...

 _ 08/01/91 US PEOP\Promotions
_ 08/01/91 WACO CAFE Cafeteria Menu for Wednesday, July 31
_ 08/01/91 US PEOP New Assignments in US Sales Staff
_ 08/01/91 CORP NEWS J. B. Stone Named to New Post
_ 08/01/91 US NEWS J. B. Stone Named to New Post

Command ===> ________________________________________________________________
 F1=Help F3=Exit F4=Prev Day F5=Next Day
 F9=Cmd Line F10=Actions F12=Cancel

á ñ

Figure 17. Sample Notice Listing panel. The asterisk next to the "Promotions" notice in
US/PEOP indicates that this is a new notice posted since the last time the user accessed
BULLETIN.

Each line in the list contains the date the notice was published, the category and
topic it was published under, and a short title describing the subject matter. An
asterisk (*) between the topic and title fields indicates that this is a new notice that
has not been presented to you before. A user entry field precedes each line on the
list.

The list of notices will be presented in one of two ways:

� CUMULATIVE - all new notices are grouped together, with the most recent at
the top of the list. You can identify this mode because the heading of the first
data column will be "Date."

� DAILY - notices are grouped by publishing date. The display will start with the
date of the oldest notice in the categories/topics you selected. You can identify
this mode because the heading of the first data column will be the day of the
week. In this example the notices are displayed in daily mode, as shown by
the heading of the first data column which is "Thurs".

The system programmer who installed BULLETIN at your site defined which mode
is the default. Individual users may change this setting using the environment
function from the "Options" action bar item.
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How does BULLETIN determine which notices to display?
BULLETIN remembers which notices you accessed during your last BULLETIN
session, and will start by displaying any new notices that have been posted since
since your last access. If no new notices have been posted in the categories you
selected, you will instead be shown today's notices in Daily mode (even if you
choose cumulative display in the environment function).

When BULLETIN presents you with a list of notices, it is assumed that you will
process the notices listed at that time. It then sets and stores the internal flags
indicating the last notice displayed in each category/topic accordingly. For
example, in the previous figure, the notice entitled "Promotions" was flagged as a
new notice. The next time you access the BULLETIN system, this notice will no
longer be flagged as a new notice, regardless of whether or not you actually read
the notice during the BULLETIN session.

BULLETIN allows you to select or subscribe to the categories and topics that
interest you the most. Because you could miss important news this way, special
reserved categories and topics are used in BULLETIN. When news is posted in
these special areas, the notices will always be listed. You are not forced to read
these notices; they will just be listed along with all the other notices in the
categories and topics that you are subscribed to or have selected. These
categories are referred to as required reading. For company-wide or national news,
these items will be posted in the category/topic REQD READ. Required notices for
local categories are posted in the topic REQD.

When viewing notices in daily mode, you can advance the listing of notices one day
at a time by using the "Next Day" and "Previous Day" operations. These are
available as PF Keys1 and as operations from the Search action bar pull-down.
You may not advance past today's date, and weekends (Saturdays and Sundays)
are skipped.

If you wish to immediately jump to today's date, you can select that function from
the Search action bar pull-down menu, or by typing: TODAY on the command line.

Applying Functions to Items in a List
To execute a function against a notice in the list, type the appropriate action code
in the entry field in front of the notice, then press Enter. Or you can type the select
character '/' in the entry field, move the cursor to the action bar and press Enter,
then select the appropriate function.

More than one notice and function can be selected at a time. If you use the select
character '/', the function you choose from the action bar will be applied to all the
notices you selected. If you use the action codes, you can mix any combination of
action codes and notices. The character '=' will repeat the previously selected
function.

In both cases, you use the Cancel PF key to advance from one notice/function to
the next. If you wish to stop before processing all your selections, the Exit PF key
will return you to the Notice Listing Panel. Those functions that have completed will

1 See “PF Key Assignments” on page 39 for information on PF Key definitions.
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have a '*' in their entry fields. You can make whatever changes you want, then
press Enter to continue processing.

BULLETIN 1.1 now has the capability of applying a function to all notices in a list
by typing only a single action code. This line ("Apply to all notices in this list") will
always appear just below the header whenever there is more than one notice in the
list, even when scrolling forwards and backwards. An action code entered next to
an individual notice will take precedence over one entered in the "Apply to all" line
when that notice is processed.
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Chapter 6. Function Operation and Panels

In this section we will describe in detail the functions available in BULLETIN, and
show examples of the panels associated with each function.

 Read Notice
From the notice listing screen, you may select one or more notices to be read by
placing 'R' or '/' in the entry field and pressing Enter. You may also select one
notice to be read by placing the cursor on that notice and pressing Enter.
BULLETIN will then display each notice using the read notice panel illustrated
below.

à@ ð
File Feedback Options Help

 ---------------------------------------------------------------------------
 Read Notice

Thursday, August 1, 1991 (CORP NEWS)

J. B. STONE NAMED TO NEW POST
 _____________________________

John B. Stone has been named director of quality, reporting to Tom
Goodyear, vice president.

Mr. Stone was director of operations, Computer Services.

End of Notice

COMMAND ===> ________________________________________________________________
 F1=Help F3=Exit
 F10=Actions F12=Cancel

á ñ

Figure 18. Sample Read Notice panel
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 Copy Notice

The copy notice function allows the end-user to copy an individual notice to a
minidisk. It may be invoked in several ways:

� From the read notice panel

– Select the File action bar item and press Enter
– Then select the copy notice function from the pull-down menu

� From the notice listing panel

– Type 'C' in the action code field next to the notice title
– Or, type '/' in the action code field, and then select the File action bar item.

Select the copy notice function from the pull-down menu displayed.

The copy notice panel will then be displayed as follows:

à@ ð
 ----------------------------------------------------------------------------
 | Copy Notice |
 | |
| This function will place on one of your minidisks a copy of the notice: |
| 08/01/91 CORP NEWS J. B. Stone Named to New Post |

 | |
| Type over any fields if desired, then press Enter. |

 | |
| Filename . . . . . . . . . . . . . . 91080102 |
| Filetype . . . . . . . . . . . . . . CORPNEWS |
| Filemode . . . . . . . . . . . . . . A |

 | |
 | |
 | |
 | |
 | |
 | |
 | F1=Help F12=Cancel |
 ----------------------------------------------------------------------------

COMMAND ===> ________________________________________________________________
 F1=Help F3=Exit F4=Prev Day F5=Next Day
 F9=Cmd Line F10=Actions F12=Cancel

á ñ

Figure 19. Copy Notice Pop-Up panel
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The default filename and filetype are those used to store the notice on the system.
The default filemode is 'A' which will place the notice on the end-user's A-disk. To
choose a different name for the file just type over those fields. When ready to
copy, press the Enter key.

If there currently exists a file with the same filename, filetype and filemode, the user
can replace the file, append to it, or choose a different name.

à@ ð
 ----------------------------------------------------------------------------
 | Copy Notice |
 | |
| This function will place on one of your minidisks a copy of the notice: |
| 08/01/91 CORP NEWS J. B. Stone Named to New Post |

 | |
| Type over any fields if desired, then press Enter. |

 | |
| Filename . . . . . . . . . . . . . . 91080102 |
| Filetype . . . . . . . . . . . . . . CORPNEWS |
| Filemode . . . . . . . . . . . . . . A |

 | |
| A file by that name already exists. |
| Do you want to . . . . . . . . . . . 1. Replace existing file |
| 2. Append to existing file |
| 3. Enter a different name |

 | |
 | F1=Help F12=Cancel |
 ----------------------------------------------------------------------------

COMMAND ===> ________________________________________________________________
 F1=Help F3=Exit F4=Prev Day F5=Next Day
 F9=Cmd Line F10=Actions F12=Cancel

á ñ

Figure 20. Copy Notice panel when file already exists
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 Print Notice

The print notice function allows the end-user to print an individual notice. It may be
invoked in several ways:

� From the read notice panel

– Select the File action bar item and press Enter
– Then select the print notice function from the pull-down menu

� From the notice listing panel

– Type 'P' in the action code field next to the notice title
– Or, type '/' in the action code field, and then select the File action bar item.

Select the print notice function from the pull-down menu displayed.

BULLETIN will then invoke the print utility. The actual print command used is
defined by your system administrator. You may override this routine using the
environment option. See “Environment Settings” on page 43 for more information.

Since the screen displayed will vary depending on the print utility used at your
location, no example is shown.

24 BULLETIN User’s Guide  



  
 

 Send Notice
The send notice function allows the user to send a copy of the notice to one or
more other users. When sending the notice, the user may include comment lines
which will be attached to the top of the file. The notice may be sent as a CMS file
or a PROFS/OVVM note.

As with the copy notice command, the send notice function can be accessed in
several ways.

� From the read notice panel

– Select the File action bar item and press Enter
– Then select the send notice function from the pull-down menu

� From the notice listing panel

– Type 'S' in the action code field next to the notice title
– Or, type '/' in the action code field, and then select the File action bar item.

Select the send notice function from the pull-down menu displayed.

The send notice panel will then be displayed as follows:

à@ ð
 ----------------------------------------------------------------------------
 | Send Notice |
 | |
| This function will send to other users a copy of the notice: |
| 08/01/91 CORP NEWS J. B. Stone Named to New Post |

 | |
| Fill in the fields, then press Enter. |

 | |
| Send to . . . . . ? Userid, CMS nickname, or PROFS distribution |
| At . . . . . . . ? Node |

 | |
| Attach comments. . . . _ 1. Yes |

 | 2. No |
 | |
| Send notice as a . . . 1 1. PROFS or OV/VM note |
| 2. CMS file |

 | |
 | |
| F1=Help F3=Exit F12=Cancel |

 ----------------------------------------------------------------------------
á ñ

Figure 21. Send Notice Pop-Up panel

The "Send To" field can contain either a userid, a CMS nickname, or a PROFS or
OfficeVision distribution list. If you are sending to an individual userid, type their
system node in the 'At' field. If nothing is entered for the 'At' field, it will default to
the same node you are on.

You may also specify whether the notice will be sent as a CMS file, or as a PROFS
or OfficeVision note. If the notice is sent as a CMS file, the filename and filetype of
the original notice will be used. The default for this field is based on the setting in
the Environment function, found on the Options pull-down.
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If you wish to add comments to the beginning of the notice (for example, to let
them know why you are sending it), type '1' for 'Yes' in the 'Attach comments' field.
Ater pressing Enter, you will go into an XEDIT session where you can compose
your comments. All XEDIT commands are supported.

When you are finished writing your comments, press the PF Key labelled "Send".

à@ ð
 Send Notice

Your comments will be attached concerning:
08/01/91 CORP NEWS J. B. Stone Named to New Post

Enter your comments below, then press the Send (F10) key.

00001
00002
00003
00004
00005
00006
00007
00008
00009
00010
00011
00012
00013

 Command ===> _________________________________________________________________
 F1=Help F2=Prefix F3=Exit F4=Del line F5=Add line
F7=Backward F8=Forward F9=Command F10=Send F12=Cancel

á ñ

Figure 22. Send Notice Comment Panel
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 Feedback
The feedback function allows the end-user to either send comments about an
individual notice to the notice author, or to send general comments about the
BULLETIN tool to the local administrator. The feedback function may be accessed
from:

� The action bar on all panels (for general feedback about your local BULLETIN
system)

� The read notice panel

– Select the Feedback action bar item and press Enter

� The notice listing panel

– Type 'F' in the action code field next to the notice title
– Or, type '/' in the action code field, and then select the Feedback action bar

item. The end-user then selects either general feedback or individual
notice feedback from the pull-down panel.

à@ ð
 Feedback

Your comments will be sent to CORPCOMM at BIGHQVM concerning:
08/01/91 CORP NEWS J. B. Stone Named to New Post

Enter your comments below, then press the Send (F10) key.

00001
00002
00003
00004
00005
00006
00007
00008
00009
00010
00011
00012
00013

 Command ===> _________________________________________________________________
 F1=Help F2=Prefix F3=Exit F4=Del line F5=Add line
F7=Backward F8=Forward F9=Command F10=Send F12=Cancel

á ñ

Figure 23. Feedback panel

At the top of the screen the subject of the feedback note will be shown, along with
the node and userid of the person who will be receiving this note. You are in an
XEDIT session where you can compose your comments. All XEDIT commands are
supported. When completed, press the function key labelled "Send" to send the
feedback item.
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 Search Functions
The search functions are available from the action bar on the category listing and
notice listing panels. To select the search functions place the cursor on the
"Search" item on the action bar and press Enter. The search pull-down menu will
then be displayed, listing all of the available searches. These searches are
described in the following sections.

To return to the panel you came from before beginning the searches, select
"Cancel Searches" from the search pull-down.

Search by Date

à@ ð
Search by Date

Type your choices, then press Enter.

National notices available since . . . 11/03/91
Local notices available since . . . . 01/22/91

Choose from notices in . . . . . . . . _ 1. Entire database
2. National categories
3. Local categories
4. Selected categories

List notices published on . . . . . . __ / __ / __ mm/dd/yy

 F1=Help F12=Cancel
á ñ

Figure 24. Search by Date panel

"Search by Date" allows you to display notices that were published on a specific
date. For reference, you are shown the dates of the oldest national and local
notices available at your site.

You can perform your search among the following subsets:

1. The entire database, consisting of all national and local notices
2. National notices only
3. Local notices only
4. Selected categories consisting of those you selected on the category listing

panel or are subscribed to (this function is only valid on the notice listing
panel).
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To begin the search, select one of the above subsets, type in the date, and then
press Enter. When the search is complete, the notices which matched the search
criteria will be displayed on the notices listing screen.
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Search by Category

à@ ð
Search by Category

Type your choices, then press Enter.

National notices available since . . . 11/03/91
Local notices available since . . . . 01/22/91

Choose notices in the category . . . . ?

between . . . . . . . . . . . . . . . 02 / 01 / 91 mm/dd/yy
and . . . . . . . . . . . . . . . . . 01 / 22 / 92 mm/dd/yy

 F1=Help F12=Cancel
á ñ

Figure 25. Search by Category panel

"Search by Category" allows you to display notices that were published under a
specific category. For reference, you are shown the dates of the oldest national
and local notices available at your site.

You may further refine your search by specifying the date range to be searched.
When you initially enter BULLETIN, the date range will be set to equal the entire
database. The values you enter will then be remembered and used the next time
you invoke a search function during this active session of BULLETIN.

To begin the search, type in the category name, adjust the date ranges if
necessary, then press Enter. Using '*' as the category name will display all  notices
in the database that were published between the date ranges. When the search is
complete, the notices which matched the search criteria will be displayed on the
notices listing screen. This display will be in cumulative mode.
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Search by Notice Title

à@ ð
Search by Notice Title

Type your choices, then press Enter.

National notices available since . . . 11/03/91
Local notices available since . . . . 01/22/91

Choose from notices in . . . . . . . . _ 1. Entire database
2. National categories
3. Local categories
4. Selected categories

Choose notices with the string . . . ?

in their titles that were published
between . . . . . . . . . . . . . . . 02 / 01 / 91 mm/dd/yy
and . . . . . . . . . . . . . . . . . 01 / 22 / 92 mm/dd/yy

 F1=Help F12=Cancel
á ñ

Figure 26. Search by Notice Title panel

"Search by Notice Title" allows you to display notices that contain a specific
character string in their title. For reference, you are shown the dates of the oldest
national and local notices available at your site.

You can perform your search among the following subsets:

1. The entire database, consisting of all national and local notices
2. National notices only
3. Local notices only
4. Selected categories consisting of those you selected on the category listing

panel or are subscribed to (this function is only valid on the notice listing
panel).

You can also narrow your search to notices that appeared between two dates, as
described in the "Search by Category" function.

To begin the search, select one of the above subsets, type in the character string
(no imbedded blanks), adjust the date ranges if necessary, then press Enter. You
will be advised of the status of the search by a counter at the bottom of the screen
that indicates the number of notices being searched.
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à@ ð
Search by Notice Title

Type your choices, then press Enter.

National notices available since . . . 11/03/91
Local notices available since . . . . 01/22/91

Choose from notices in . . . . . . . . 1 1. Entire database
2. National categories
3. Local categories
4. Selected categories

Choose notices with the string . . . IBM

in their titles that were published
between . . . . . . . . . . . . . . . 02 / 01 / 91 mm/dd/yy
and . . . . . . . . . . . . . . . . . 01 / 22 / 92 mm/dd/yy

Your request will search 2490 notices.
Do you want to continue? . . . . . . . _ (Y/N)

 F1=Help F12=Cancel
á ñ

Figure 27. Proceed with large searches?

If the search will involve more than 200 notices, you will be asked whether you
wish to proceed with the search. 'Y' will continue with the search, 'N' will allow you
to modify your input, and the Cancel PF key will cancel the search function.

When the search is completed, you will be returned to a notice listing panel that
tells you how many notices were found. The display will be in cumulative mode.
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Search by Notice Content

à@ ð
Search by Notice Content

Type your choices, then press Enter.

National notices available since . . . 11/03/91
Local notices available since . . . . 01/22/91

Choose from notices in . . . . . . . . _ 1. Entire database
2. National categories
3. Local categories
4. Selected categories

Choose notices with the string . . . ?

in their text that were published
between . . . . . . . . . . . . . . . 02 / 01 / 91 mm/dd/yy
and . . . . . . . . . . . . . . . . . 01 / 22 / 92 mm/dd/yy

 F1=Help F12=Cancel
á ñ

Figure 28. Search by Notice Content panel

"Search by Notice Content" allows you to display notices that contain a specific
character string within their text. The fields and operation of the function are
identical to the "Search by Notice Title" function.

When the search is complete, you will be returned to a notice listing panel that tells
you how many notices were found. The display will be in cumulative mode.

Note:  Be advised that the search could take some time based on the number and
size of notices to be searched. As in the "Search by Notice Title" function, you will
be advised if your search involves more than 200 notices.
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 Stored Notices

à@ ð
File Search Feedback Options Help

 ---------------------------------------------------------------------------

 Stored Notices

Select notices by typing '/' or an Action Code, then press Enter
 C=Copy D=Delete Stored Notice F=Feedback P=Print R=Read S=Send

Date Cat Top Title
_ 08/01/91 CORP NEWS J. B. Stone Named to New Post

COMMAND ===> ________________________________________________________________
 F1=Help F2=Stored F3=Exit
 F9=Cmd Line F10=Actions F12=Cancel

á ñ

Figure 29. Stored Notices panel

"Stored Notices" are a way for you to flag notices that you wish to either read or
process at a later time. These notices are not actually "stored" (that is, copied to a
minidisk), but rather are marked by an internal flag set in BULLETIN. To add a
notice to your list of Stored Notices, either use the 'A' action code from a notice
listing panel or select 'Add Stored Notice' from the File pull-down.

When you have any Stored Notices, an indicator in the upper right hand corner of
all Notice Listing and Category Listing panels will tell you how many there are. To
view your list of stored notices, select the Notices/Stored Notices choice from the
Search pull-down panel. Use the same option to leave your stored notices. You
can also assign a PF Key to this function.

The stored notices panel operates exactly the same as the notice listing panel.
The stored notices are listed in cumulative mode. When a stored notice is no
longer needed, it may be removed by either using the 'D' action code from the
stored notices panel or by selecting 'Delete Stored Notice' from the File pull-down.

How long will a stored notice stay on the system?
Once you have stored a notice, it will remain in your stored notice listing until one
of two conditions is met:

� You delete the notice from your stored notice listing
� The notice expires and is erased by the BULLETIN control programs

In order to save a copy of a notice beyond the expiration date, the copy notice
function should be used.
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 Subscriptions

à@ ð
 ------------------------------------------------------------
 | Subscriptions |
 | |
| Existing subscriptions are indicated by an 'S'. |
| Type an 'S' to start a subscription, or a blank |
| to remove one. Then press Enter. |

 | |
| Act Catg Top Description |

 | _ AFR NEWS Africa News |
 | _ ASIA NEWS Asia News |
 | _ AUS NEWS Australia News |
 | _ CAN NEWS Canada News |
 | _ CORP NEWS Corporate News |
 | _ EUR NEWS Europe News |
 | _ SA NEWS S. America News |
 | _ US NEWS United States News |
 | |
 | |
 | F1=Help F8=Forward F12=Cancel |
 ------------------------------------------------------------

á ñ

Figure 30. Subscription Pop-Up panel

This function may be accessed:

� From the Options pull-down menu located on the action bar. Move the cursor
to the subscriptions field and press Enter.

� From the category listing panel by placing an 'S' in the entry field next to one or
more categories.

� From the category listing panel by placing a '/' in the entry field next to one or
more categories. Then select the File function from the action bar. Move the
cursor to the subscriptions option on the pull-down menu and press Enter.

Note that when you access the subscriptions function from the Options pull-down
menu, all available categories and topics on your system will be listed. If you
select specific categories from the category listing panel, then only those categories
and their associated topics will be listed.

The subscription system allows the end-user to select those categories and topics
that are most important to them. Once the end-user has created a subscription,
each time they access BULLETIN it bypasses the Category Listing panel and
presents the Notice Listing panel which displays the new notices in their subscribed
categories and topics.

The subscription screen lists each topic under the categories selected, along with a
short description of the types of notices posted there. Any existing subscriptions
will be indicated by an 'S' in the entry field. To create a new subscription, type an
'S' in the entry field. To delete a subscription, type a blank over the 'S'. When
completed, press Enter to process.
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Some categories and topics will be designated as Required Reading by your local
and National administrators, and will be indicated by a '*'. Notices posted in these
categories/topics are deemed to be highly important, and are always presented to
you, no matter what your subscriptions or category selections are.
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All Notices (90 days)

à@ ð
File Search Feedback Options Help

 ---------------------------------------------------------------------------
 Category Listing

Select Categories by typing '/' or an Action Code, then press Enter.
A=All notices (90 days) N=New Notices S=Subscriptions

 More: +
 Act Description
 Local News

_ NYC - New York City

 National News
_ REQD - Required Reading
_ AFR - Africa News
_ ASIA - Asia News
_ AUS - Australia News
_ CAN - Canada News
_ CORP - Corporate News
_ EUR - Europe News
_ SA - S. America News

Command ===> ______________________________________________________________
 F1=Help F3=Exit
 F8=Forward F9=Cmd Line F10=Actions F12=Cancel

á ñ

This function may be accessed:

� From the category listing panel by placing an 'A' in the entry field next to one or
more categories.

� From the category listing panel by placing a '/' in the entry field next to one or
more categories. Then select the File function from the action bar. Move the
cursor to the All notices option on the pull-down menu and press Enter.

This function will allow you to display all the notices posted in the last 90 days in
the selected categories. Ninety days was chosen to avoid overloading the system
when used with Local Categories, where notices are often kept in the database for
long periods of time. Ninety days is also the default length of time that notices
posted in the National categories remain in the BULLETIN database before they
expire.

The various functions available on the Action Bar under "Search" should continue
to be used if you need to obtain notices more than 90 days old.
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Chapter 7. Customizing the BULLETIN Environment

PF Key Assignments

à@ ð
PF Key Assignments

Type a new key number next to each function (0 for no assignment) or in the
Process field choose Reset, then press Enter. Then choose Accept Values.

Mandatory Definitions New Current Process . . . . . . _
Help . . . . . . . . . . . . . __ 1 1. Reset to system defaults
Forward . . . . . . . . . . . __ 8 2. Reset to original values
Backward . . . . . . . . . . . __ 7 3. Accept values
Switch to Action Bar/Send . . __ 10
Cancel . . . . . . . . . . . . __ 12 Unassigned PF Keys

Optional Definitions ( 6 11 )
Exit . . . . . . . . . . . . . __ 3
Command . . . . . . . . . . . __ 9
Next Day . . . . . . . . . . . __ 5
Previous Day . . . . . . . . . __ 4
Stored Notices/Print . . . . . __ 2

 F1=Help F12=Cancel
á ñ

Figure 31. PF Key Assignments panel

The PF Key assignment function is available by selecting the 'Options' item from
any action bar. It allows you to change the functions assigned to your display's
Programmable Function keys (PF Keys). Only PF Keys 1-12 are supported by
BULLETIN. PF13-24, if available, are remapped to 1-12. Only BULLETIN
operations may be assigned to the function keys.

Five functions are mandatory, in that you must assign PF Keys to them: Help,
Forward, Backward, Action Bar and Cancel. These functions are considered the
bare minimum necessary in order to use BULLETIN.

To assign a function to a PF Key, type the PF Key number next to the function
name. To remove an assignment (that is, to not have a key assigned to that
function), type the number 0. Then press Enter. The new values will then appear
in the column labeled "Current". It is important to remember that no changes have
taken place yet. "Current" is only showing what you currently would like assigned
to those functions.

 Copyright IBM Corp. 1992  39



  
 

To help you keep track of which keys have not yet been assigned, the "Unassigned
PF Keys" field on the right side of the screen will show you the current list of
available PF Keys. This list is updated whenever you press Enter.

If you want to quit without reassigning the keys, press the Cancel key.

When you are satisfied with your choices, go to the "Process" field and type '3'
("Accept Values"), then press Enter.

The program will then check that:

1. Values have been assigned to the five mandatory functions
2. No key has been assigned to more than one function

If errors are detected, an appropriate message will appear at the bottom of the
screen, and arrows will point to the fields in error. You can then correct the errors,
and process again.

Two other process options are available. Option 1 will reset the definitions to the
system default values. Option 2 will reset the assignments so they match the
assignments you had when you accessed this option. If you have changed the PF
Key assignments, be sure to select process option 3 to accept these new values.

The PF Keys provide a handy shortcut for accessing frequently used BULLETIN
functions. Regardless of how you define your PF Keys, all BULLETIN functions will
still be available from the action bar pull-down menus.
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 Color Definitions

à@ ð
 Color Definitions

Type in color or hilite codes, or in the Process field choose Reset, then
press Enter. You will be shown the results. Then choose Accept Values.

 New Current
Item Color / Hilite Color / Hilite

 Text . . . . . . . . . . . . . _ / _ GREEN NONE Colors
 Titles . . . . . . . . . . . . _ / _ BLUE NONE 1. Blue
PF Keys . . . . . . . . . . . . _ / _ BLUE NONE 2. Red
Action Bar/Pull-Downs . . . . . _ / _ WHITE NONE 3. Pink
Selected Fields . . . . . . . . _ / _ YELLO NONE 4. Green
Pop-Ups . . . . . . . . . . . . _ / _ GREEN NONE 5. Turq
Input fields . . . . . . . . . _ / _ TURQ NONE 6. Yello
Information Messages . . . . . _ / _ WHITE NONE 7. White
Error Messages . . . . . . . . _ / _ RED NONE

 Hilite
Process . . . . . . _ 1. Reset to system defaults 1. None

2. Reset to original values 2. Blink
3. Accept values 3. Rev

 4. Under

 F1=Help F12=Cancel
á ñ

Figure 32. Color Definitions panel

This function is available from the Options pull-down menu on the action bar of all
panels. It allows you to change the colors and the types of highlighting of various
elements of the BULLETIN screens. Remember that not all colors or highlighting
options are available on all displays and PC emulators. Consult your display and/or
emulator manual if you do not get the results you expect.

The existing color and highlighting settings for each screen element are shown. In
the "Color" column the name of the color is written in that color. In the "Hilite"
column, the highlighting assigned will be written in that color/highlighting
combination. The "Color" column is always written with no highlighting.

For example, if all PF Keys are to appear in red reverse, the word "RED" will
appear in the "Color" column in red characters on a black background, while the
word "REV" will appear in the "Hilite" column in black letters on a red background.

To change the colors or highlighting for any of the screen elements, type the
corresponding number in the columns labeled "New". Valid numbers for colors are
1-7, and for highlighting are 1-4. When you press Enter, your changes will be put
in the "Current" columns for your inspection.
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If you wish to quit without reassigning any definitions, press the Cancel key.

When you are satisfied with your choices, go to the "Process" field and type '3'
("Accept Values"), then press Enter.

If you type '1' in the "Process" field, the assignments will be changed to the system
default values. Choice 2 ("Original Values") will return to the assignments you had
when you first entered this panel. You can then accept these values or make
further modifications. If you have made any changes, be sure to select process
option 3 to accept these new values.
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 Environment Settings

à@ ð
 Environment

Fill in fields, then press Enter.

Display new notices . . . . . . . . . 1 1. By individual days
 2. Cumulative

List duplicate notices . . . . . . . 1 1. Yes
 2. No

FastEnter . . . . . . . . . . . . . . 1 1. On
 2. Off

Send notice as a . . . . . . . . . . 1 1. PROFS/OVVM Note
2. CMS Files

Print using . . . . . . . . . . . . . 2 1. PROFS/OVVM
2. I/S recommended EXEC (HARDCOPY)
3. Your own EXEC . . . ________

 F1=Help F12=Cancel
á ñ

Figure 33. Environment panel

This function is available from the Options pull-down menu on the action bar on all
panels. It allows you to change the ways notices are listed and handled in
BULLETIN. Your existing settings are shown in the entry fields.

1. Display new notices

This determines the mode used to display new notices when first entering
BULLETIN.

When "By Individual Days" is selected, notices will be grouped by date
published. A separate screen will be used for each date. All new notices will
be displayed, with the oldest of these displayed first.

In "Cumulative" mode, all new notices are displayed on the same screen. The
most recent notices are displayed first.

2. List duplicate notices

Some national notices may be published in more than one category. Choosing
"No" will ensure that only one copy of the notice is displayed. BULLETIN will
display the copy of the notice that is published in the highest organizational
category (as determined by the national system administrator). Choosing "Yes"
means that duplicate copies will be displayed.

 3. FastEnter

This allows the Enter key to be used as an intelligent scroll key while reading
individual notices. Each time you press the Enter key, it duplicates the action
of the Scroll Forward key. However, when you reach the end of the notice,
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"FastEnter" will also go to the next notice or function you've selected,
duplicating the "Next Notice" function. With "FastEnter", the Enter key is the
only key you need to press to read all of your selected notices.

4. Send notice as a

This determines the default used when you send a notice to another end-user
or group of end-users.

 5. Print using

When printing a notice, BULLETIN will first check to see if you have
PROFS/OfficeVision so that it can make use of the PROFS HARDCOPY or
OFFICE HARDCOPY command. If not, it will use the CMS print routine that
was selected by the local BULLETIN installer. You can override this, and tell
BULLETIN to instead always use the default printing EXEC specified (option 2),
or to use an EXEC of your choice (option 3). If you pick option 3, you will be
prompted to enter the name of your EXEC.
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 Chapter 8. BULLETIN Warnings

à@ ð
 ----------------------------------------------------------------------------
 | BULLETIN Warnings |
 | |
 | Problem with your PF Key definitions - reset to system defaults |
 | Problem with your Color definitions - reset to system defaults |
 | Problem with your Hilighting definitions - reset to system defaults |
 | |
 | You had Stored Notices marked for the following dates, categories, |
 | and topics which could not be found. They have either expired or |
 | have been deleted from the BULLETIN database by the publishers. |
 | |
 | Date Catg Top |
 | 07/15/91 US PEOP |
 | |
 | The following Stored Notices will expire within the next 7 days. |
 | You should process them as soon as possible. |
 | |
 | Days remaining |
 | v Date Catg Top Title |
 | 5 08/01/91 CORP NEWS J. B. Stone Named to New Post |
 | |
 | F1=Help F12=Cancel |
 ----------------------------------------------------------------------------

á ñ

Figure 34. BULLETIN Warnings panel

This panel warns and informs you of changes or problems that were detected with
your BULLETIN settings for PF keys or colors and highlightings. If they are either
corrupted or erased, you will be reassigned the default values.

It also warns you of problems with the notices you have previously selected as your
Stored Notices. Since the Stored Notices function is simply a pointer, it is
dependant upon the notice actually being in the database for you to work with it.
Should the notice reach its expiration date, or the owner of the notice decide to
delete it, you no longer have any way of accessing it.

This panel lists your Stored Notices that have already been deleted from the
system, along with any that are scheduled to expire within the next 7 days.

Since the title of the Stored Notice is not part of the pointer, BULLETIN cannot tell
you exactly which notice may have been deleted. It can tell you the date of the
notice, along with the Category and Topic it appeared in.

For those notices that will expire within the next week, BULLETIN also tells you
how many days they have remaining. You should take immediate steps to either
complete whatever processing you wish to do to the notices, or use the "Copy
Notice" function to store them on one of your minidisks.
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Chapter 9. End-user Data Files

The file LASTING GLOBALV is used to store many of the BULLETIN settings that
you can alter (such as color and PF Key assignments, environment, last day
accessed, etc.). As expected, you cannot erase or modify this file without the risk
of significant impact to not only BULLETIN, but any other programs you access that
make use of LASTING GLOBALV. You should use the facilities provided within
BULLETIN to change these settings (from the Options pull-down).

BULLETIN also creates and updates a file on your A-disk called $BULLET$
USERDATA. This file contains the names of all the categories and topics available
at your site, along with the date and sequence number of the last notice in each
category/topic that was presented to you in a notice listing panel. It also indicates
whether or not you are subscribed to that category/topic.

If you have any stored notices, then a second file called $BULLET$ REMINDER is
also written to your A-disk. This file contains the filename and filetype of your
stored notices.

To indicate the nature of these files and the fact that you should never alter the
contents, both files contain the following header in lines 1-3:

Bulletin User Data
\\Do Not Modify\\

 -----------------

You should take care never to erase these files, otherwise you will lose the records
of your previous BULLETIN sessions.
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 Appendix A. SAA/CUA

BULLETIN was written to conform to the guidelines of IBM's Systems Application
Architecture (SAA) Common User Access (CUA) for non-programmable ter-
minals. This manual will provide only a basic overview of CUA concepts and opera-
tion. If end-users desire more information with regards to the implementation of
CUA standards, they should refer to "IBM Systems Application Architecture:
Common User Access Basic Interface Design Guide, SC26-4583."

BULLETIN deviates from the CUA standard in the following areas:

� Extended Help and Prompt are not implemented, as the basic Help screens
provide sufficient detail.

� The function key assignments for Forward and Backward are not displayed on
a panel if movement is not possible in that direction. This is to provide addi-
tional indication (besides the Scrolling Arrows) that the end-user is at the top or
bottom of the panel.

� Panels which allow the end-user to input several lines of text (such as Feed-
back) do not process when the end-user presses the Enter key. This is to
allow the end-user the maximum amount of flexibility while editing. Instead,
processing begins when a function key labeled "Send" is pressed. This key is
the same one that is used for the "Switch to Action Bar" function.

� The "PF Key assignments and "Color definitions" panels also do not process
when Enter is pressed, due to the major effect this could have if the end-user
made the wrong choices. An additional entry field is used by the end-user to
indicate when processing should begin.

Registered Trademark of International Business Machines Corporation

Trademark of International Business Machines Corporation
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 Appendix B. CUA Fundamentals

This section is included for end-users who are not familiar with CUA applications.
Having a basic understanding of the terminology and operation of CUA architecture
will allow end-users to quickly make effective use of the power of BULLETIN.

 Basic Definitions
The following definitions were taken from the Glossary of the "IBM Systems Appli-
cation Architecture: Common User Access Basic Interface Design Guide,
SC26-4583."

Accelerator:  A key or combination of keys that invokes an application-defined
function. The end-user term is function key.

Action:  One of the defined tasks that an application performs. Actions modify the
properties of an object or manipulate the object in some way.

Action Bar:  The area at the top of a primary window that contains keywords that
give end-users access to actions available in that window. After end-users request
a choice in the Action Bar, a Pull-Down extension appears from the Action Bar.

Action Bar Pull-Down:  An extension of the Action Bar that displays a list of avail-
able choices for a selected choice in the Action Bar.

Action Codes:  Numbers or letters assigned to actions in an Action List.

Action Entry Field:  The entry field used in action lists. End-users can type an
action code to invoke one of several possible actions against the object.

Action-Object:  A process sequence in which end-users select an action and then
the objects to apply that action to. Contrast with Object-Action.

Action List:  A set of choices that allows end-users to select multiple objects and
to specify that a different action be performed on each object at the same time.

Actions:  See Switch to Action Bar.

Backward:  A scrolling action that displays information above the information that
is currently visible in a panel area.

Cancel:  An action that removes the current panel without processing it and
returns the dialog to the previous panel in the hierarchy. Contrast with Exit.

Enter:  An action that submits information to the computer for processing. Enter
tells the computer to perform selected actions on selected objects. Remember that
select means to mark a choice; Enter means to send all designated choices to the
computer for processing.

Exit:  An action that ends a function or application and removes from the screen all
windows associated with that function or application. Contrast with Cancel.
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File:  A standard choice in the Action Bar that enables end-users to work with
stored objects.

Forward:  A scrolling action that displays information below the information that is
currently visible in a panel area.

Function Key Area:  The area at the bottom of a panel that contains function key
assignments.

More:  See Scrolling arrows.

Object-Action:  A process sequence in which end-users select an object and then
select an action to apply to that object. Contrast with Action-Object.

Options:  A standard choice in the Action Bar that allows end-users to customize
an application object.

Pop-Up:  A bordered area of the screen that supplements the dialog that is occur-
ring in the primary window.

Primary Window:  The window in which the main dialog takes place between the
end-users and the application.

Pull-Down:  See Action Bar Pull-Down.

Scrolling Arrows:  A type of scrolling information that consists of the word More
followed by a colon and arrows or symbols that indicate the direction in which more
information is available through scrolling.

Select:  To mark or choose an item. Remember that select means to mark a
choice; Enter means to send all designated choices to the computer for processing.

Switch to Action Bar:  An action that moves the cursor to and from the action
bar. It is listed as Actions in the function key area.

Window:  An area of the screen with visible boundaries through which panel infor-
mation is displayed. A window can be smaller in size or equal in size to the
screen. Windows can overlap on the screen and give the appearance of one
window being on top of another.

Entry and Selection
It is important to remember in a CUA application the distinction between Enter/Entry
and Select/Selection.

With Entry, end-users type character or numeric information. By Selection, end-
users choose from a group of related choices that are presented in the panel. The
word Select means to pick a choice.

Selection is the implementation of the Object-Action philosophy that is the back-
bone of CUA design. First the end-user selects their choice of objects, then they
pick the action to perform on those objects. These actions are usually found in one
of the Action Bar Pull-Down menus.
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The Selection Character used in BULLETIN, and most other CUA-based U.S. appli-
cations, is the slash (/).
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